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About this manual

Introduction

This manual provides an introduction to the basic functionality available in WYSIWYG 
and is designed to get you started using the program. It is recommended that you use 
this manual while running the Quick Start Tutorial. The tutorial provides both video and 
audio elements to help you progress through the 14 lessons. This guide contains a text 
version of the audio portion of the tutorial, along with accompanying graphics. It also 
contains some additional information that is not included in the tutorials.

You can access the tutorial from the WYSIWYG Install panel. 

Note: To view the video portion of the Quick Start Tutorial, you must have the 
TechSmith Screen Capture Codec (TSCC) installed on your machine. This codec is 
available on the WYSIWYG CD for your convenience.

Text conventions

The following text conventions are used in this manual:

 Menus and menu commands appear in Arial bold. For example, “from the Library 
menu, choose Browse Library.”

 User interface elements such as buttons, tools, shortcuts, and dialog boxes 
appear in Tahoma Oblique. For example, “to draw a riser, click the Riser tool on the 
Draw toolbar.”

 Keyboard keys are indicated in ALL CAPS. For example, “press the TAB key to 
enter the missing coordinate.”

 References to manuals appear in italic font. For example, “for additional 
information on rendering, refer to the Reference Guide.”
Quick Start Guide 5
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Lesson 1 - Understanding the user interface

Introduction

In this lesson you will learn about the basic parts of the WYSIWYG user interface. 

Step 1 - Starting to work in WYSIWYG

To start working in WYSIWYG

1 From the WYSIWYG Welcome window, choose a file to open. You can choose to 
open an existing file or create a new file. A list of template files are shown on the 
right and a list of files you have recently used are shown under Open File. 

2 For the purposes of this tutorial, click Empty. 

Result: The WYSIWYG main window is displayed. 
Quick Start Guide 7
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Layout tabs

Shortcut bar

Toolbars

Menu bar

Mode buttons

Step 2 - Mode buttons

The buttons across the top are the mode buttons. Based on the WYSIWYG product that 
you have purchased, the mode buttons available are some or all of the following: 

 CAD - This is where you will do all of your drawing.
 Data - This is where all of your show information is tabulated on a spreadsheet.
 Design - This mode allows you to turn lights on, compose static lighting looks, and 

generate renderings. 
 Presentation - This is where you create printouts of your show document including 

reports, plots, and images. 
 Live - This is where you pre-cue and visualize your lighting show. 

Step 3 - Menu bar, toolbars, layout tabs

Below the mode buttons is the menu bar. The available menus change as needed when 
moving from mode to mode. 

Below the menu bar are the toolbars. Toolbars provide button access to most 
commands and can be used in lieu of the menu bar. 

Located at the bottom of the screen are layout tabs. Each mode has designated layouts. 
A layout is the configuration of views in your workspace. 
8
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Step 4 - Shortcut bar

The shortcut bar is located on the left side of your screen. You can create shortcuts for 
library items, ease of navigation, and special tools. For example, you can save a 
navigation shortcut to Live mode/Quad layout so that the next time you want to go back 
to that location, you can simply click the shortcut. 

To create this shortcut

1 Select the navigation shortcut bar, right-click, and then select New Navigation. 

2 Type a name for the shortcut and click OK.
Quick Start Guide 9
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Lesson 2 - Creating a set

Introduction

In this lesson you will learn how to:

 insert a venue
 build your set using the following methods:

 from CAD objects
 from library items
 using CAD tools

Step 1 - Inserting a venue

Begin in CAD mode. This is the mode in which you create your show drawings. In this 
example, you add a proscenium arch theatre.

To insert a venue

1 From the Draw menu, choose Venue > Proscenium Arch.
Quick Start Guide 11
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2 Accept the default values, and then click OK. 

Result: Your plan view now contains a plan drawing of a proscenium arch theatre. 

Step 2 - Building your set from CAD objects

A number of CAD objects are available from the Draw menu. You can create a set from 
basic CAD objects such as circles, spheres, cylinders, and risers. In this example, you 
will insert a riser.

To build your set from CAD objects

1 From the Draw menu, choose Riser. 

2 In the applicable boxes, specify the dimensions of the riser, for example, 8'x8'x2'.

3 Click OK. 

4 Click to drop the riser in your drawing.

Step 3 - Building your set from library items

Use the pre-drawn items in the WYSIWYG library to insert objects in the drawing. In this 
example, you insert a motorcycle.
12
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To build your set from library items

1 From the Library menu, choose Browse Library. 

2 Select the library item tool  at the bottom of the library browser to ensure that 
you are browsing the scenic library. 

3 Navigate to the desired item, and then double-click to insert. 

Tip: You can save time by using the Library Search feature. In the Library browser, 
simply click the category tab that you are interested in, and then type the object 
name (or part of it) in the Search box at the top of the browser panel. All objects 
that match your query are shown.

4 Move the mouse to a point on stage. Before dropping the object in the drawing, 
press TAB to display the Enter the missing coordinate dialog box. 

The missing coordinate (X,Y,Z) is the coordinate whose value cannot be entered by 
clicking on the screen. 
Quick Start Guide 13
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5 Enter the value for the missing CAD coordinate, for example, 2' (the height of the 
riser), and then click OK.

Tip: As you move your cursor the coordinates are displayed in the bottom right 
corner of the screen. 

6 Click to place the object on top of the riser.

Step 4 - Building your set using CAD tools

WYSIWYG is equipped with powerful CAD tools allowing you to draw anything from 
scratch. In this example, you will draw a basic cyc to illustrate some of these tools.

To draw objects using the CAD tools

1 From the Draw toolbar, select the item that you want to draw, for example a line. 

2 To pick the first point of line, type the coordinates (for example, -20,20,0), and 
then press ENTER. 

Note: When you start typing, the ComEdit toolbar is activated at the bottom of the 
window. 

3 Specify the coordinates for the end point of the line (for example, 20,20,0), and 
then press ENTER. 

4 Right-click and select Finish Line.

To extrude a line into a surface

1 With the line still selected, from the Tools menu, click Extrude, and then choose 
Lines into surfaces. 

2 Enter the value for the extrusion distance, for example 20, and then click OK.

Result: The line is stretched into a surface.

Switch to Shaded view to view your final set design. Your set should look similar to the 
following:
14



December 2014 Lesson 3 - Defining hanging positions
Lesson 3 - Defining hanging positions

Introduction

Once the set is in place, you can define your hang structures. All fixtures in WYSIWYG 
must be placed on a hang structure, which can be either a pipe or truss.

In this lesson you will learn how to insert a hang structure and define the position 
names in your document.

Step 1 - Defining a position name

Position names are used to identify hang structures. To organize and sort the position 
names, use the Position Manager available in WYSIWYG. The order in which the position 
names appear in the Position Manager defines how they are sorted in reports. 

To define a new position name 

1 From the Edit menu, choose Positions. 

2 Click New, and then enter the name of the position.

3 Repeat step 2 for all position names as desired. 

4 To sort the position names, use the Up and Down buttons to move the selected 
name in the list. 

Step 2 - Drawing a pipe

Pipe hang structures can be drawn using the Draw menu.
Quick Start Guide 15
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To draw a pipe

1 From the Draw menu, choose Pipe.

2 Choose the associated position name as defined in “To define a new position name” 
on page 15.

3 Specify the dimensions for the pipe (for this example, accept the defaults), and 
then click OK. 

4 Click or type to place the pipe in your drawing. 

Step 3 - Inserting truss

Truss hang structures can be inserted from the library. 

To insert truss

1 Activate the Assembly snap tool  to ensure truss pieces are bolted together.

2 From the Library menu, choose Browse Library.

3 Click the truss tool  at the bottom of the Library browser to ensure that you are 
browsing the truss library 

4 Navigate to the desired piece, and then double-click in your drawing to insert it. 

5 Hover your cursor over your drawing where you want to insert the object. Press 
TAB to set the missing coordinate before clicking to place the piece of truss in your 
drawing.

6 Click to place the first piece of truss.

7 To assemble subsequent pieces, hover the cursor over the end of the piece of truss 
you want to attach it to and it will automatically snap into position.

Tip: It is easiest to place your first truss on the left side of your screen, and 
continue to build your truss by adding new pieces to the right end.

8 Once the piece has snapped into position, click to insert it into the drawing.

9 When you are finished placing truss, right click and select Finish Placing Truss.
16
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Indicators for truss assembly
When hanging or selecting truss, a 3D indicator appears, displaying a directional/
positional reference for the individual piece of truss. You can use these indicators as a 
visual guide, helping you to assemble truss structures and instantly determine if a truss 
piece was not assembled as intended.

Tips:
 These 3D indicators are in no way related to WYSIWYG’s coordinate system.
 It is highly recommended that you build truss structures in Isometric view and 

follow the left-to-right truss assembly rule.
 When a truss structure is completed, as long as the indicators for all the 

component pieces align (taking into consideration corner blocks and connectors – 
see example below), fixtures will hang correctly from this structure. 

Indicators are visible whenever you select truss or when you are in the process of 
assembling/inserting it. When you are snapping a new piece of truss to an existing 
piece, if you see that the indicator for the existing piece does not align with the 
indicator for the new piece, right-click and select a different mount point, or roll the 
truss as necessary (rolling truss usually applies to triangular truss or with corner 
blocks), to ensure that the two indicators align.

Naturally, corner blocks and connectors have to be taken into consideration. For 
example, in the truss structure shown below (starting from the bottom left-most section 
and traversing counter-clockwise), the two truss pieces along the bottom have 
matching indicators.

When the 90º corner block is used, the “running direction” of the truss changes. As 
such, the next truss piece is now rotated as shown by its indicator. This continues all the 
way around this rectangular truss structure until we connect back to the bottom left 
corner. 

As the example demonstrates, while not all indicators will align in the same orientation 
(which would be impossible), the assembly may still be correct. When creating truss 
structures, take a moment at each corner block to analyze how the running direction of 
the truss changes due to the corner block. To do so, look at the indicator alone and 
visualize what would happen if you rotated it by 90º (or another angle, depending on 
what corner block/connector you are using). 
Quick Start Guide 17
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If the indicator of the existing piece had the red line pointing to your right and green 
pointing up, rotating it 90º counter-clockwise would cause the green line to point to 
your left and the red to point up, while rotating the indicator 90º clockwise would cause 
the green line to point right and the red arrow to point down. 

These are the only two cases in which fixtures hanging from the two pieces attached to 
the 90º corner block would behave “as expected”; should the indicators appear in any 
other positions, undo and assemble the truss again, making sure not to activate any of 
the right-click roll/alternate mountpoint options as you begin the assembly.

As you can see from the isometric screenshot of this same truss structure (below), all of 
the blue indicators are pointing in the same direction, which means that all lights hung 
from this truss will point downwards to the floor.
18
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To assign a position name 

1 Double-click the truss structure to open its properties. 

2 On the Hang Structure tab, from the Name drop-down box, select the desired name. 

3 Click OK.
Quick Start Guide 19
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Lesson 4 - Hanging and focusing fixtures

Introduction

After inserting hang structures into your drawing, you are now ready to hang and focus 
fixtures. A library of fixtures is available for you to choose from. 

In this lesson you will learn how to:

 hang fixtures
 focus fixtures

Note: You can only focus conventional fixtures in CAD mode.

Step 1 - Hanging fixtures

Fixtures are objects on the plot and must be hung from a hang structure. 

To hang fixtures

1 From the Library menu, choose Browse Library. 

2 Select the fixture tool at the bottom of the library browser to ensure that you are 
browsing the fixture library. 

3 Navigate to the desired item, right-click, and then select Insert. 

4 Move the mouse over a hanging structure (pipe or truss) and click to hang the 
fixture. 

5 When you have finished placing the fixtures, right click and select Finish Placing 
Fixtures. 

6 Repeat steps 3-5 for all desired fixture types. 

Step 2 - Inserting a focus position

There are three methods for focusing fixtures: 

 clicking and dragging the light beam of the selected fixture 
 changing the pan and tilt values by double-clicking to access the fixture’s 

properties box
 inserting focus positions

The method for inserting focus positions is described here. 

Focus positions allow you to quickly attach a focus value to a fixture. 

To insert a focus position

1 From the Draw menu, choose Focus Position. 

2 Type a label for the new focus position and then click OK. 

3 Press TAB to adjust the missing coordinate, if necessary. 

4 Click to place the focus position in the drawing. 
Quick Start Guide 21
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Step 3 - Focusing fixtures using focus positions

To associate a fixture with a focus position

1 From the Tools menu, choose Quick Focus.

2 Click on the focus position to set it as the active focus position, and then click on 
the desired fixture to set its focus position. 

3 When you are finished focusing fixtures, right-click and select Finish Quick Focus.
22
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Lesson 5 - Assigning fixture attributes

Introduction

In this lesson you will learn how to assign attributes to fixtures. 

Step 1 - Assigning attributes to fixtures

Once you have fixtures in your drawing, you may want to assign data, accessories, or 
other attributes to them. To quickly assign values to fixtures, use Quick Tools, which is 
available in CAD mode. 

The following is a brief description of each Quick Tool. For further information, you can 
also click the Help button (?) in the upper right corner of the Quick Fixture Tool window, 
and then click on the tool of your choice.

Descriptions of Quick Tools
 Quick Spot enters a spot number in the Spot box.
 Quick Unit enters a unit number in the Unit box.
 Quick Purpose enters a fixture purpose in the Purpose box.
 Quick Focus enters a focus position or pan and tilt angle for the selected fixture.
 Quick Channel enters a channel number in the Channel box.
 Quick Patch enters a patch universe assignment in the Patch box.
 Quick Dimmer enters a dimmer number in the Dimmer box.
 Quick Circuit enters a circuit name and number in the Circuit Name and Num 

boxes.
 Quick Color enters a gel color number for the selected fixtures.
 Quick Gobo enters a gobo number for the selected fixtures.
 Other enters an accessory type for the selected fixtures.

Notes: 

 When typing values, type the exact value or use the [...] browse button to open a 
selection dialog.

 The entry in the patch box must fulfill the requirements of patch notation which is 
universe.#. 

 When using the quick tools to insert a color or gobo, WYSIWYG automatically 
inserts a default color frame or gobo holder, which is already defined in the fixture. 
Remove the default frame and add a new one using Add Accessory. 

 When you are applying a color to a multi-source fixture, a dialog appears, listing 
the circuit names to which you can apply the Quick Tool color selection. To apply 
the same color to multiple circuits listed in this dialog, press CTRL, and then select 
the desired circuits. Press Select when you are finished.
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To use Quick Tools

1 From the Tools menu, choose Quick Tools.

2 Click the plus signs (+) beside each heading to expand the section and work with 
the tools.

3 Select the tool(s) that you want to activate, and enter the initial value. When you 
have completed your selections, click OK.

Result: The cursor will show a “Q” to indicate that Quick Tools has been activated.

4 Click on the fixtures one by one to assign the specified information.
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Tip: The prompt line at the bottom left corner displays the parameter information 
that will be assigned to the next fixture that is clicked on. 

5 When you are finished using Quick Tools, right-click and select Finish Quick Tools.

Step 2 - Filtering and modifying data

Any attribute associated with a fixture in your WYSIWYG drawing (for example, 
purposes, control channels, focus positions) is available for you to edit in Data mode. 
Any changes that you make are reflected throughout the entire file, including the 
drawing.

Begin in the spreadsheet. You can use data filters to quickly locate data in the 
spreadsheet.   

To use a data filter

1 In the Spreadsheet, locate the Type column and specify a filter to locate the 
fixtures you want to work with.

2 In the Filter bar, enter the text "Fresnel" to filter the Spreadsheet.

Result: The spreadsheet refreshes, displaying only the fixtures that meet the filter 
criteria.

3 Make any data changes that you require. To add or modify information, enter the 
data in the appropriate cell. You can add or modify chunks of information at the 
same time by selecting a series of cells and typing.

4 To remove the filter, just click on the X button displayed on the right side of the 
Type column, beside the filter text you entered.

Step 3 - Entering sequential numerical data

To assign a sequential patch for a list of fixtures, you can use incremental data entry to 
facilitate your work. WYSIWYG will calculate the next available value based on the 
number of required channels for the previous fixture. 

To enter sequential numerical data

1 Select the fixtures you wish to patch sequentially by click and dragging their cells 
to select them.

2 Enter the starting patch in the following format, “Universe Name.Starting 
Address +”. 

Example: Type “A.1 +” and then press ENTER. 
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Step 4 - Choosing data

To choose data

1 In some columns a drop-down is available which lists relevant data. 

Example: The Color column, a drop-down will appear displaying some options 
to help you enter the data into the cell(s). 

2 If you wish to browse the library, select "Pick from Library".

Result: This action opens the Color Select window where you can browse the gel 
catalog to select your color.
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Lesson 6 - Building lighting looks in Design mode

Introduction

In Design mode, you can create static lighting looks using the design tools. You can 
then save and render these looks to output photorealistic images. Note that you can 
only control fixture parameters that are ordinarily controlled by DMX.

You can also simulate cross-fading between lighting looks without the need of a lighting 
console by using the shortcut properties in the shortcut bar to specify the fade time in 
seconds. This is the amount of time that it takes to “fade” to this look when you click on 
it from another look in the shortcut bar. 

Once you create the look and specify the fade time, you can use the design tools to 
customize the look. When you switch from one look to the next, you can see the 
movement of the lights from one position to the next, along with any changes you have 
made between looks, such as color, intensity, and so on. 

In this lesson you will learn how to build a lighting look in Design mode and cross-fade 
to another lighting look. 

Step 1 - Creating a new lighting look 

To create a new look

1 In the Looks shortcut bar area, right-click and select New Look. 

2 Type the name of the new look (for example, Scene1).

3 In the Fade time box, type the fade time in seconds for this look, and then click OK. 

4 Create another look in the same way, this time with a different look name. 
Customize both looks in the following steps.

Step 2 - Using the Intensity tool

The zoom, intensity, and iris tools all work the same way. 
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To use the zoom, intensity, and iris tools

1 In your drawing, select the desired fixtures.

2 Open the Intensity tool, for example, by clicking the appropriate tool on the 
designer toolbar . 

Click the dial, and then move the mouse up or down to set the intensity level, or click 
Full to set the intensity to 100%. To save time, you can also use the following buttons to 
quickly adjust the intensity:

Step 3 - Using the Gobo tool

The gobo and prism toolbars work the same way. 

To use the gobo and prism tools

1 Open the Gobo tool, for example, by clicking the appropriate tool on the designer 
toolbar . 

2 To assign a gobo, with the desired fixtures selected, select the desired wheel from 
the drop-down list, and then use gobo selection arrows to choose the desired gobo.  
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Step 4 - Using the Focus tool

To use the focus tool

1 Open the Focus tool by clicking the appropriate tool on the designer toolbar . 

2 To focus automated fixtures, with the fixtures selected, choose from any of the 
following methods:

 Use the Focus Pad by clicking on the pad, and then moving the mouse.
 Use the P / T Wheels to control pan and tilt of the fixture.
 Click the Focus button, and then click in the Wireframe view at the point where 

you would like to focus the beam.
 Choose a focus position from the Focus Objects drop-down list. 
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Step 5 - Using the Color tool

To use the color tool

1 Open the Color tool by clicking the appropriate tool on the designer toolbar . 

2 To assign color, with the desired fixtures selected, click to pick a color on the 
palette or the color wheel.

3 If desired, you can use the RGB drop-down boxes to manually enter RGB, CMY, or 
HSI values.

Step 6 - Opening the Render Wizard

The Render Wizard steps you through the process of generating a rendering of your 
drawing.

To open the Render Wizard

1 With the desired lighting look active, open the Render Wizard by clicking on the 
appropriate tool on the designer toolbar . 

2 In the right pane, click and drag the mouse to set up your image.

3 In the left pane proceed through the Wizard steps by using the Next and Back 
buttons. 

For more information on the options available for rendering, consult the WYSIWYG 
Reference Guide. 

Step 7- Cross-fading between lighting looks

After setting up at least two lighting looks, you can “fade” between them by using the 
cross-fade feature.
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1 Ensure that the Fade looks button is enabled so the look fades instead of jumping 
directly to the next look. 

Tip: If the button is not enabled, then you can “jump” from one look to the next by 
clicking the look shortcuts in the shortcut bar. Even if the button is enabled, you 
can always jump to the next look by right-clicking the look shortcut, and selecting 
Jump to.

2 To watch the “fade” from the first look to the second look, click the shortcut for the 
second look. The image fades over the period of time that you specified as the fade 
time for the second look. 

Tips: 
 For a more realistic view of the fading between looks, click the Shaded tab.

 To jump directly to a specific look, right-click the look, and then select Jump to.
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Lesson 7 - Creating and modifying reports

Introduction

In Presentation (Pres) mode, a series of pre-formatted reports is available for you to 
use as is or to modify to suit your needs. Unlike the spreadsheets in Data mode, you 
cannot edit fixture data in these reports. You can, however, modify the setup and layout 
of these reports. 

In this lesson you will learn how to work with reports. 

Step 1 - Entering show information

Shortcuts to the pre-formatted reports in Presentation mode are available in the 
shortcut bar. Click the desired report shortcut to open it. Show information such as 
venue, designer, show, and assistant is displayed at the top of each report. 
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To add or modify show info

1 From the Options menu, choose Show Options.

2 Click the Production Team Info tab.

3 Click in the Value column and make the necessary changes or additions (for 
example, add John Smith as the lighting designer).

4 Click OK. 

Step 2 - Modifying a report

To modify a report

1 In the shortcut bar in Presentation mode, click a shortcut to open a report.

2 Right-click in the open report, and then choose View Options. 

Result: The View Options dialog opens with the General and Report tabs available. 
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3 Click the Report tab. 

Group By

The Group By drop-down list enables you to select a data field for grouping the 
data. These groups appear as separate tabs at the bottom of a report. Choose None 
to have all information displayed on the same page.

Columns

The Columns list displays the columns available for inclusion or exclusion in a 
report. You can display the fields in any order by arranging the order of this list 
using the Up and Down buttons. The top of the column list represents the left 
column on the page and the bottom of the list is the right column. To move a 
column up or down the list, click the column name and then use the Up/Down 
buttons. 

Sort By

The Sort By list contains the settings for how the report is sorted. The keys that you 
specify are sorted in alphabetical or numerical order. When fixtures have the same 
value in the first sort key, the report is then sorted by the second sort key, and so 
on for the third sort key. 
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When you have set all the options, click OK to save and exit. The report refreshes 
and any changes are reflected immediately.

Step 3 - Formatting report headings

To format the report headings 

1 In the report, select the text to be formatted.

2 From the Text toolbar, choose the desired alignment, font, text color, and cell fill 
options.

3 From the Report menu, select Format Cells, and then adjust the cell format, cell 
border, text alignment, font, and background colors as desired. 
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4 Select a Smart Cell drop-down and then choose the desired variable, as shown in 
the following graphic:

5 From the File menu, choose Save.

To format the report data

1 In the report, the cells below the column heading is the report data. 

2 To format any of the columns, select a cell within a column, and then use the Text 
toolbar, to set desired alignment, font, text color, and cell fill options.

Alternatively, right-click on the data section and select Format Cells. 

Note: To format cell borders, it is offered only from within the Format Cells 
dialog.

3 To turn on Zebra Striping, go to Report menu and select Zebra Striping.

4 Once you've completed your formatting changes, save your file.

Result: With some formatting to cells, and moving some of the data through copy/
paste and row/column manipulation, you can customize the look of your Report.
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Lesson 8 - Working in the New Plots view

Introduction

New Plots views were introduced so that you could more effectively manipulate a 
drawing developed in CAD mode to create a lighting plot, or “schematic”, for printing. 

Note: You cannot change the properties of items that you have inserted in CAD mode; 
you can only change the properties of items that you have inserted in the New Plots 
view.

In this lesson you will learn how to work with New Plots. 

Step 1 - Creating a New Plot

To create a New Plot

1 In Presentation mode, click the New Plots shortcut tab.

2 Right-click in the New Plots shortcut area, and then choose the type of plot that you 
want to create.

3 Type a name, and then click OK.

Note: By default, empty layouts are set up to use 24” x 36” sheets of paper. 

To modify the paper size

1 In your New Plot, right-click in the report area, and then choose View Options. 

2 From the Paper Size drop-down list, select the desired paper size. 

3 Click OK to save and exit.
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Next, you can determine the parts of the drawing that you want to see on the page by 
moving the page. 

To move the page

1 Right-click in the New Plots work area, and then choose Move Page. 

Result: The cursor turns into a hand symbol.

2 Hold down the left mouse button to grip the page and drag to move it until the 
parts of the drawing that you want are contained within the grid area. 

3 When you are finished, right-click and choose Finish Move Page. 

Step 2 - Manipulating objects on the plot

A New Plot is a snapshot projection of your CAD drawing. Once the snapshot is taken, 
you can modify objects on the New Plot without affecting the original CAD drawing.

Tip: Zoom in by pressing PAGE UP or by using the middle mouse button to facilitate the 
set-up. 

To manipulate the objects on a plot

1 In the New Plot, select an object.

2 Click and drag to modify its position; to modify the layer properties, right-click the 
object, and then choose Object Properties. 

3 Modify the properties as required.

4 Click OK.

Step 3 - Plotting non-horizontal hang structures

In the New Plots view, you can rotate non-horizontal hang structures, such as booms 
and ladders, around their base to show all mounted fixtures. This rotation can be right, 
left, top, or bottom. 

To plot non-horizontal hang structures

1 Select the hang structure.

2 Right-click and select Rotate Position.

3 Select the direction and angle in which you want to rotate the hang structure.

4 Click OK. 
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Step 4 - Inserting objects

You can add objects to the plot for notation by simply drawing or selecting them from 
the Draw menu. Objects that you can draw include lines, arcs, circles, and text labels. 
You can also insert symbols from the Library Browser.

To insert objects

1 From the Draw menu, choose the object that you want to insert. 

Note: Choosing Symbol opens the Library Browser. 

2 In the properties box that opens, type the properties of your object.

Note: If you choose Interactive, you can change the size of the object manually.

3 Click OK, and then click in the plot to place the object.

Tip: You can resize objects by clicking and dragging them.

To add arrows to lines

1 Select the line to which you want to add one or more arrows.

2 Right-click and select Object Properties.

3 Click the Line tab. 

4 Select where you want the arrows to appear, either at the start or end of the line, 
or both places.

5 Click OK.

To change a single line to a double line

1 Select the line that you want to modify.

2 Right-click it, and then select Object Properties.

3 Click the Line tab. 

4 Select the Double Line check box.

5 Click OK.
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Lesson 9 - Creating and modifying layouts

Introduction

In WYSIWYG, layouts are created by arranging various CAD, report, image, and other 
items on a defined paper size. 

In this lesson you will learn how to work with layouts. 

Step 1 - Creating a new layout

To create a new layout

1 In Presentation mode, click the Layouts shortcut tab.

2 Right-click in the Layouts shortcut area, and then choose New Layout.

3 Type a name, and then click OK.

Note: By default, empty layouts are set up to use 8.5” x 11” sheets of paper. 

To modify the paper size

1 Right-click in the layout area and choose View Options. 
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2 From the Paper Size drop-down list, select the desired paper size. 

3 Click OK to save your changes and exit.

You may now begin placing objects on the sheet of paper. Use the Pres Insert toolbar to 
facilitate the process.

Tip: Zoom in by pressing PAGE UP to facilitate the setup. 

Step 2 - Inserting objects into the layout

To insert objects on the layout

1 To insert and object, select the appropriate icon from the Pres Insert toolbar.

Line
Rectangle

Rounded Rectangle

Ellipse

Polygon

Text

Image

CAD Item
Spreadsheet Item

Report Item

Worksheet Item

Legend
Key

New Plot Item

Create Layout Template

Insert Layout Template

Delete Layout Template

2 Click and drag a window (placeholder) on the layout where you want the item to 
appear.

3 Repeat this procedure for all desired items. 

Step 3 - Modifying CAD items

To modify CAD items

In this example you will modify the scale of a drawing item. 
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1 Select the CAD item, right-click, and then choose Content Properties. 

2 Click the CAD Printing tab.

3 Click the Fixed option button.

4 From the drop-down list, select Custom.

5 Type the scaling to be used when printing the drawing, for example, fixed at
1/8”=1’. 

6 Select any other desired items, and then click OK.

Step 4 - Adding legends and keys

The Legend and Key Wizards guide you through the process of adding a legend or key 
to your layout. 

 Legends: You may want to add a legend to your layout to provide a definition of 
the symbols used in the layout. The legend you create can include the symbol 
name, wattage, count, and any other special notes. 

 Keys: You may want to add a key to your layout to provide a definition for the 
fixture notation used in the layout. The key you create can include the symbol of 
one given fixture and identifiers for the various attributes notated around the 
symbol. 

To create a legend

1 Right-click in the Wizards shortcut bar, and then select New Legend.

Result: The Enter new Legend name dialog box is displayed.
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2 Type a name for the legend, and then click OK. 

Result: The legend shortcut is stored in the shortcut bar and the Legend Wizard 
opens. The Legend Symbols Editor appears as displayed below. All fixtures in your 
CAD drawing are listed in the Legend Editor for possible inclusion in the Legend. All 
the options to configure your Legend are available from this dialog. 

a. Legend layout
Options found here affect the layout of your legend.

 Title: The Title field will display the name of the legend. Type a title in the Title 
box if you want a title other than the default name to be displayed. 

 Automatic updates: By default, this option is on and will automatically update the 
legend when there are updates in your CAD drawing

 Display Columns: The Display Column button is used to edit what columns are 
displayed in the legend. Clicking the button will bring up the Legend Options 
window. From here choose the columns that you want displayed by marking the 
appropriate columns from the list. The Symbol and Name columns are displayed 
by default. Order the display of columns by clicking the Up and Down buttons. 
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 Move Up: Select a row and use this button to move the fixture row up in the 
table. 

 Move Down: Select a row and use this button to move the fixture row down in 
the table. 

 Reset to Default: When a fixture row is selected that has cells that have been 
edited, this button becomes active. By clicking this button, the all the editable 
cells in the row will be reset to their default text. 

 Symbol: The Fixture Symbol section displays up to three symbols that represent 
a fixture from different views, Plan, Front, Side, if available. Use the checkbox 
under each symbol if you wish it in the Legend. 

Note:  At least one symbol must be displayed for each symbol.  

b. Legend information

Each symbol type that exists in your CAD drawing is displayed for possible 
inclusion in the legend. The counts of each symbol type is updated automatically as 
symbols with the same symbol type are added or deleted from the CAD drawing. 

Options found here affect the symbol information that is displayed in the legend. 

 Display checkbox: By default all fixtures are displayed in the legend, as identified 
by the check box. Click to deselect this check box if you do not want the 
highlighted fixture in the table to be displayed in the Legend.  

 Symbol: This column displays the name of the Symbol from the Library which 
represents the fixture in your CAD drawing and will be displayed for this fixture 
on the Legend. 

 Name: By default, the name of the fixture will be displayed, as listed in the 
Library Browser. If you wish to edit the displayed fixture name, click in the cell 
and type in your preferred Name for display. 

 Count: By default, the total number of the fixture in the drawing appears in the 
Count column. This value includes only hung fixtures in your show file. If you 
wish to edit this number, click in the cell and enter a new count. 

 Spares: By default, this column is blank. If you have spare fixtures that you 
would like to display on your Legend, click in the cell and enter a number of 
Spares. 

 Wattage: By default, the table displays the wattage for the Lamp in volts. If you 
wish to edit this value, click on the cell and enter a new Wattage value. 

 Lamp: displays the lamp of the fixture.    
 Fixture Options: displays any options that are available on the fixture. To edit 

this cell, click on it and add or remove any of the text. 
 Notes: Type in any additional notes that should be displayed for this fixture in 

the Legend. 
 Color Source: By default, the Color Source will be set to Plot Color, which means 

the Legend will automatically display the symbol using the Layer Color or Object 
Color of the fixture, if the color is the same for all instances of the fixture in your 
drawing. If the color is not the same, the Plot Color will automatically be set to 
Black. Alternatively, you switch this column to Custom Color, and then use the 
column beside it using the colorbox to select a custom color for the symbol. 

 Color: Click the Colorbox to open a color picker. Select the new color that you 
want to apply to the symbol, and then click OK 

 Rotate: By default the checkbox is unchecked to display the fixture symbol in its 
default orientation. To rotate the symbol, click on the checkbox and select it.

c. Legend display options

How a legend appears in a report can be customized to meet your needs. 
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Options found here affect how a legend appears in the report.

 Display Legend Title: Enable this option to display a title for your legend.
 Display column headings: Enable this option to display the headings of columns in 

the legend.
 Display grid: Enable this option to show a grid separating symbols in the legend.
 Max column width: The number sets the width of the columns. The width must be 

set in order to set Word Wrap option. (Note: The minimum width for a column is 
30).

 Word wrap: Enable this option to wrap text that exceeds the max column width.
 Font: Use the drop-down menu to select a support font style 
 Font Size: Set the font size for all text in the legend layout. 

To create key items

1 Right-click in the Wizards shortcut bar, and then select New Key.

Result: The Enter new Key name dialog box is displayed.

2 Type a name for the key, and then click OK. 

Result: The key shortcut is stored in the shortcut bar and the Key Wizard opens. 

Step 1 - Key Symbol Selection

Options in Step 1 allow you to choose the symbol that will represent the fixture or 
accessory in the key. 

 List of symbols: Select the symbols you want to use. You can choose up to one 
fixture symbol and one accessories symbol. The symbols available in this list are 
the default WYSIWYG symbols for each fixture or accessory type. When you 
selecting a symbol, it appears in the preview window to the right. 

 Title: Select the Display Title check box if you want the name of the symbol to be 
displayed in the key. Type a title in the Title box if you want a title other than the 
default name to be displayed.

 Change Symbol: Enables you to choose a different symbol from the more extensive 
symbols library which includes the USITT standards, among others. Follow the 
steps in “Changing Symbols” to perform the modifications.
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 Delete Symbol: Click this button to remove the selected symbol from the preview 
window. 

Changing symbols

From the list of items in the window to the right of the preview window, select the 
symbol. To change the symbol, click the Change Symbol button. The following dialog 
box appears:

From the list on the left side, choose the new symbol. When you are finished 
making your choice, click Select. 

Step 2 - Symbol Layout

 

For each attribute there are two entries in the list box. One is for the attribute 
itself; the other is to label the attribute. The label is distinguishable by the qualifier 
“Key” (for example, the attribute Focus and the label Key - Focus). An extension line 
is drawn between the label and the attribute. For each attribute and its label you 
must decide whether you want to display it in the key. If yes, you can further 
specify how it will be displayed using the various formatting options (including text 
size and color, shape size and color, and justification).

You can also edit all the text, choose to give examples of attribute values, and 
provide custom definitions for the labels.
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Options in Step 2 allow you to choose the attributes and notation to be displayed 
around the chosen symbols. 

Note: To make the controls active, you may have to click to clear the Use Defaults 
check box. 

 Visible: Select this check box if you want the attribute or label to be displayed 
around the symbol in your key.

 Use Body Color: Select this check box if you want the attribute or label to use the 
same font color as the symbol. To set a specific color for the attribute or label, 
leave the box unchecked and click the color box to choose a custom color.

 Line weight: Adjust this value to increase or decrease the density of the label or 
attribute font.

 Text: Type the text that you want displayed for the attribute or label. 
 Italics: Select this check box to italicize the attribute or label font. Note there are 

no options to change the font.
 Horizontal and vertical justification: Choose the justification for the text. This is in 

relation to the insertion point or shape.
 Height: Increase or decrease to modify the font size.
 Angle: Specifies the attribute or label alignment in relation to the fixture symbol.
 Shape: Associate a shape with the label or attribute, if desired. You can choose 

from: none, circle, square, octagon, or diamond.
 Size: Increase or decrease the size of the shape as desired.

3 Set the position of the attribute or label by clicking and dragging on the label or 
attribute in the preview window. You can also select an attribute by clicking on it in 
the preview window. 

4 The key as it will be drawn on the layout is displayed in the preview window. Once 
all the attributes are set as desired, click Finish.

Result: The Wizard shortcut is stored in the shortcut bar with the name you 
specified in the Title box. 

To place the legend or key

1 On the Insert toolbar, either the Legend or Key icon.

2 Click and drag a window placeholder on the layout where you want the legend or 
key to appear.

Result: A message box prompts you to select the legend or key from the list. 

3 Highlight the legend or key, and then click Select.
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Lesson 10 - Patching

Introduction

In WYSIWYG, you can create two types of patch universes:

 DMX - When you create this type of patch universe, you can patch fixtures or 
movement axes to it by assigning them a DMX address. The patch screen in Data 
mode is a visual representation of your DMX patch setup and is also used to 
monitor DMX activity while connected to a console.

 Motion Control - When you create this type of patch universe, you can patch 
movement axes to it, and then use a motion control system (or WYSIWYG’s Motion 
Control Console) to control the movement of any objects that are attached to the 
axis.

In this lesson you will learn how to patch fixtures and read a resulting patch universe.

Step 1 - Creating a new patch universe

To create a new patch universe

1 In Data mode, click the Patch tab.

2 Click the Patch shortcut bar. 

Result: The Patch shortcuts are displayed.

3 Right-click in the shortcut bar, and then select New Patch. 

4 Type the name of the patch universe. Patch universes can be named anything. For 
example, “A”, “Dimmers”, “Dim”, “Movers”, “Scrollers”, and so on.

5 Select the type of patch universe based on the type of console or system that you 
are using, either a DMX console, or a motion control system.

6 Click OK.

Result: The patch shortcut appears in the Patch tab.

Step 2 - Patching fixtures and movement axes in the patch layout 
screen

To patch fixtures and movement axes in the patch layout screen

1 In the CAD drawing in the top portion of the window, click to select the desired 
fixture or movement axis.

2 Click and drag the fixture/movement axis into the DMX or motion control patch 
universe at the bottom of the window.

3 Repeat for all fixtures/movement axes as desired. 
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Step 3 - Repatching a fixture

To repatch a fixture

Select the desired fixture by clicking its first DMX attribute directly in the patch 
universe, and then drag it to a new address.

Step 4 - Reading the patch

Reading the DMX patch

The name of the patch universe is displayed in the title bar. 

Each box in the patch universe represents one DMX channel. Fixtures are represented 
by colored bumps that span the number of required DMX channels. 

If you are connected to a console and are receiving a DMX signal, the incoming DMX 
values are displayed in the top right corner of each box. 

The number in the upper left corner of each box is the DMX address. 

The fixture parameter controlled by each channel is identified in the center of the box. 

The spot number and fixture type span the center of the box. 

Reading the patch for streaming video sources
If you have patched a live video source or file, the patch appears as shown below:
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Reading the patch for moving scenery
If you have patched a movement axis, the patch appears as shown below:

 For linear movement axes, the position of the object is reported in either metric or 
imperial units (for example, 16m). 

 For rotational axes, the value is shown in degrees (for example, 42°).
 If the axis is unrecognized by the motion controller, then the object position is 

shown as a question mark (?).

Note: If the axis type is mismatched between that which you have drawn and the type 
that you choose in the Motion Control Console (for example, if the actual axis is linear, 
but you choose rotational in the Motion Control Console), then the cell in patch view 
turns to red.
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Lesson 11 - Inserting and connecting to a console

Introduction

WYSIWYG enables you to visualize and pre-cue your lighting show in real time. To use 
Live mode, you must be connected to a DMX console, compatible off-line editor, or a 
motion control system.

Note: Ensure that your hardware and/or software is properly set up.

In this lesson you will learn how to insert a console and connect that console in Live 
mode. 

Step 1 - Inserting a console

To insert a console

1 From the Live menu, choose Device Manager.

2 Click New.

3 Expand the Manufacturer section, and then choose the desired console (for 
example, Express 24/48). 

4 Click Insert. 
Quick Start Guide 55



Lesson 11 - Inserting and connecting to a console  Release 34
Step 2 - Connecting to a console

To bind the console output to the patch universe

1 In the Device Manager window, highlight the console, and then click Properties. 

2 From the Protocol drop-down list, select the protocol used by the console. For 
example, DMX, SandNet. 

Result: The console model is displayed in the Model box. The name of the console 
is displayed in the Name box. 

3 In the Address box, type the designated address of the console, if applicable.

4 A list of the output ports from the console appears in the Ports list. You must bind 
these outputs to WYSIWYG patch universes. Click the appropriate port to highlight 
it.

Note: Motion control systems have a single port named “Motion.”

5 Click the Universe column to display a drop-down arrow, and then select the 
WYSIWYG universe to patch to the selected port.

Note: If you are working with a motion control system, then you can bind only to 
motion universes; if you are working with a DMX console then you can bind only to 
DMX universes.

6 Repeat the above steps to bind all ports to their appropriate patch universes. 

7 Click OK to close the Properties box.

8 Click Connect. 

Result: The status of the console changes to “connected.”

9 Click OK to exit the Device Manager.

Note: Once the console is running and connected to the WYSIWYG drawing, 
operate the console as you would in the live venue. Run up channels and record 
cues using the console. Remember that WYSIWYG does not store or save cues—
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this is done in your console’s memory. Once the console information is set up, you 
can set WYSIWYG to automatically connect to the console every time the file is 
opened.
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Lesson 12 - Using streaming video

Introduction

You can bring a live or pre-recorded video into WYSIWYG and play it back while you set 
looks in Design mode and while you precue in Live mode. 

The Video Manager enables you to create video sources (and subsources) which you 
can then assign to screens, 3D primitives (surfaces, risers, spheres, cylinders, and 
cones), LED Walls, and to projectors that you have inserted in your file from the Video 
Projection section of the Fixtures library.

Live video comes from an external source, such as a video capture device or a CITP/
MSEX video stream from a media server. Pre-recorded video comes from video files, 
either in AVI or MPG format.

Notes: If you cannot view these file types, you may not have the proper CODEC 
installed on your PC. Install the appropriate CODEC, and then try viewing the file again. 

Video sources can be split it up into subsources, which enables you to apply portions of 
the video to multiple screens, 3D primitives, LED Walls, or projectors. For details on 
splitting video, see the WYSIWYG Reference Guide.

Once you configure the video source and attach it to an object, you use the Video 
Designer Tool in Design mode to play the video.

In this lesson you will learn how to

 configure a new video source with the Video Manager
 draw the screen on which the video will play and assign the video source to it
 use the Video design tool to play the video
 use a console to play the video
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Step 1 - Configuring a new video source

To configure a new video source for streaming video
In this step you create a new video source for streaming video with the Video Manager. 
You can select a video file or you can capture a live video stream from an external 
source, such as a video capture device that is attached to your computer (provided that 
you have WYSIWYG Perform). 

For video files, you must select one of the following video file formats for playback:

 Motion Picture Experts Group (MPEG)
 Audio-Video Interleaved (AVI) 

Note: If you cannot view these file types, you may not have the proper decoder 
installed on your PC. Install the appropriate decoder, and then try viewing the file again. 
For help on installing the decoder, consult the developer of the video file type.

For live video streams, your capture device must be using WDM drivers.

Note: You can only incorporate live video if you have WYSIWYG Perform; you cannot 
use a live video from a video capture device or video streaming via CITP/MSEX if you 
have WYSIWYG Design.

1 Click Tools > Video Manager. 

2 Click the New icon in the upper-left corner.

Result: The Video Source window opens.

3 In the Name box, type a descriptive name for the video.

 To play a video from a file, click the Video File option button, and then click 
Browse to locate the file.

 To capture a live video stream from an external source, such as a web cam or 
a video capture device that is attached to your computer, click Video Capture, 
and then use the drop-down arrow to select the appropriate device. (This 
option is available only if you are running WYSIWYG Perform.) WYSIWYG will 
detect what standard resolutions the capture device can support, and display 
them in the Resolution drop-down box; click this drop-down to choose your 
preferred resolution.

 If you select a video capture option, configure the Input and Resolution values 
for the device:

 Input: Choose between various inputs found on video capture devices 
(e.g., HDMI, DVI, S-Video, and so on). 

 Resolution: Select the resolution of the incoming video, provided that 
multiple resolutions are available from the selected input.

Note: The video capture device must already be configured on your computer and 
must be using WDM drivers. Also, it must not be currently in use by another 
application.

 To stream video from a media server on your network, first ensure that the 
CITP Interface option is enabled on the Application Options > Additional 
Interfaces tab, as detailed in the WYSIWYG Reference Guide. (This option is 
only available if you are running WYSIWYG Perform.) Then, click CITP Video 
Stream and click Browse to select one of the media servers from the network. If 
you have just enabled this option, you will need to restart WYSIWYG before 
the CITP interface is turned on.

Note: In order for the media servers to be detected, they must be in the same 
logical network as your WYSIWYG computer and any and all firewalls (on your 
60



December 2014 Lesson 12 - Using streaming video
WYSIWYG computer, on the media servers, if applicable, and so on) must be 
disabled. For more information about how to correctly assign IP addresses for this 
purpose, consult your Media Server and/or Microsoft Windows documentation.

4 If your media server is capable of outputting several video streams at once, you 
may select which output/stream to connect to by entering the number of the 
output/stream in the Video Num box. If you leave the default value of 0, WYSIWYG 
will connect to the first output; if you enter the number 1, WYSIWYG connects to 
the second output/stream of the same media server; the number 2 connects to the 
third output/stream, and so on.

5 To control video playback via DMX, click DMX Patch, and then use the drop-down 
arrow to select the appropriate patch universe to control the video. In the box to 
the right of the drop-down list, type the starting DMX address. 

Note: A patch universe cannot be created from within the Video Manager dialog; if 
you wish to patch video control to DMX, you must create the necessary patch 
universe(s) before you open the Video Manager.

6 To mute the sound of the video, in the Video Manager table, click the checkbox in 
the Mute column. If you do not select this checkbox, the video’s sound will play.

7 Click OK. If the video is available, it connects automatically.

8 Click OK to save your changes and close the Video Manager.

Step 2 - Drawing a screen and attaching the video source

To draw a screen and attach the video source

1 From the Draw menu, click Screen.

2 In the appropriate boxes, type the width and height of the screen (or accept the 
default width of 8 feet and height of 6 feet).

3 To configure the image that will appear on the screen, click the appropriate option 
button:

 To leave the screen blank, click the Blank Screen option button.

 To show a static image on the screen, click the Image File option button, and 
then click Browse to locate the graphic. 

 To attach the video source that you have just configured to the screen, click 
the Video Source option button, and then choose the video source from the 
drop-down box.

4 Click OK.

Step 3 - Using the Video design tool to play the video

After you draw the screen and attach the video source, you use the Video Designer Tool 
in Design mode to start the playback or stream. You can view the video in any of the 
shaded views, using the controls on the Video designer tool to pause, fast forward, 
rewind, or stop the video. 

To use the Video design tool to play the video

Once you have the video source attached to the screen, you must use the Video design 
tool to control it.
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Note: If the video control is patched and DMX connected in Live Mode, then you will not 
be able to control the video using any of the Video design tool commands in Design 
mode. Video sources can only be controlled by a designer tool when the DMX source is 
disconnected; therefore, you must first disconnect the applicable console device from 
within Live Mode before using any of the Video design tool commands.

1 Click the Design mode button.

2 Click the Shaded tab to view the video screen(s) that you have drawn.

3 Click the Video design tool icon to open the tool window. 

4 From the drop-down list, select the video source. 

5 Use the controls shown in the graphic above to play, pause, or stop the video. You 
can also use the slider to manually advance or rewind the video at your desired 
speed. 

Note: When you press the Pause button, the frame of the video that is playing at 
the time is held on the video screen; when you press the Stop button, the video 
stops playing and the screen goes blank and the video returns to the beginning. 

Step 4 - Controlling the video with a console device

You can also patch the control of the video source to a console device. This means that 
you can use the console device to control the progress of a live video stream or a video 
file by making the video play, pause, or rewind; you cannot use WYSIWYG to change 
different aspects of the video itself. 

Note: To control the video source with a console device, you must have selected DMX 
Patch in the Video Source window in Step 1, and then chosen the patch universe for the 
video source. Also, your console device must be connected.

To control a DMX patched video source with a console

After you have patched the control of a video source in Data mode, you can use the 
applicable console device to control the progress of the video in Live mode. 

To control the video source, the DMX patch is allocated three channels, each given a 
different name in the patch window: 

 The first channel is called Intensity.
 The second channel is called Control.
 The third channel is called Position. 

For details on the channel levels, see the Reference Guide. 
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1 Click the Live mode button.

2 Click the Shaded tab.

3 Ensure that the console device is connected to the patched video source. 

 To play the video from start to finish, perform the following steps:

a. Set the first channel (Intensity) to a value between 128—255 (above 50%).

b. Set the second channel (Control) to a value between 170—255 (between 66% 
and 100%).

 To pause the video, perform the following steps:

a. Set the first channel (Intensity) to a value between 128—255 (above 50%).

b. Set the second channel (Control) to a value between 170—255 (between 66% 
and 100%) and play the video to the spot where you want to pause it. Then 
move the second channel to a value between 85—169 (between 33% and 
66%) to pause the video at this spot.

 To control the progress of the video manually, perform the following steps:

a. Set the first channel (Intensity) to a value between 128—255 (above 50%).

b. Set the second channel (Control) to a value between 1—84 (between 1% and 
33%).

c. Slide the third channel (Position) up and down to control the progress of the 
video, forward and backward. 

Notes: 

 Before you render your drawing, you can either pause the video at the precise 
image you want to see in the final rendering, or you can let the video run while the 
Render Wizard processes the information in your drawing. In this case, the Render 
Wizard captures the video frame that was showing when it processed the screen 
information. 

 If the video control is patched and DMX connected in Live Mode, then you will not 
be able to control the video using any of the Video Designer Tool commands in 
Design mode. Video sources can only be controlled by a designer tool when the 
DMX source is disconnected; therefore, you must first disconnect the applicable 
console device from Live Mode before using any of the Video Designer Tool 
commands. 
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Lesson 13 - Using moving scenery

Introduction

You can view moving scenery in WYSIWYG by creating linear or rotation movement 
axes, attaching objects to them, patching them in Data mode, and then using a motion 
control system (or WYSIWYG’s Motion Control Console) to define the object’s position 
along the axis. You can attach objects such as risers, library objects, or custom objects 
that you have drawn. 

Notes: 

 When attaching axes to one another, you cannot create a circular linking pattern. 
For example, you can link Axis A to Axis B, and then link Axis B to Axis C, but you 
cannot then link Axis C back to Axis A because this creates a circular link.

 You cannot attach fixtures to movement axes; however, you can attach pipes that 
hold fixtures to axes. 

 Currently, you cannot attach focus positions or groups containing focus positions to 
movement axes. However, in future releases you will be able to attach either of 
these items to movement axes.

Step 1 - Drawing the movement axis

To draw a linear movement axis

1 In CAD mode Wireframe view, select the view in which you want to draw the axis 
(plan, front, back, side, or isometric)

2 Click Draw > Axis > Linear Axis.

3 In the window that appears, type a name for the axis, and then click OK.

4 In your drawing, click in the position where you want to start the axis, and then 
move your cursor to the next point of the axis and click. To create an axis with 
multiple segments, continue clicking at each point (vertex) of the axis. 

5 When you are finished creating the axis, right-click and choose Finish Axis.

To draw a rotation movement axis

Note: Unlike linear axes, rotation axes cannot have multiple vertices. Instead, when 
you draw one of these axes, the object rotates around the center point.

1 In CAD mode Wireframe view, select the view in which you want to draw the axis 
(plan, front, back, side, or isometric).

2 Click Draw > Axis > Rotation Axis.

3 In the window that appears, type a name for the axis, and then click OK.

4 In your drawing, click in the position where you want the axis to appear.

Note: The circle that appears when you draw a rotation axis is only a visual cue to 
show you the direction in which the object rotates—it does not affect the size of 
path on which the object rotates. The circle is given a default size, but you can 
change it to suit your needs.
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Step 2 - Attaching a movement axis to a patch universe

To attach a movement axis to a DMX patch universe
To move the object with a DMX control, you first have to attach the movement axis to a 
named DMX patch universe that you have created in Data mode.

Note: For information on creating a patch universe, see “Step 1 - Creating a new patch 
universe” on page 51.

1 Click to select the axis that you want to attach to the patch universe.

2 Right-click and select Properties.

3 Click the Axis tab.

4 Click the DMX Patch option button.

5 From the Universe drop-down box, select the DMX patch universe to which you want 
to attach the axis.

6 In the Address box, type the starting DMX address.

7 Click OK.

To attach a movement axis to a motion patch universe
To move the object with a motion control system, you first have to attach the 
movement axis to a named motion control patch universe that you have created in Data 
mode. 

Note: For information on creating a patch universe, see “Step 1 - Creating a new patch 
universe” on page 51.

1 Click to select the axis that you want to attach to the patch universe.

2 Right-click and select Properties.

3 Click the Axis tab.

4 Click the Motion Patch option button.

5 From the Universe drop-down box, select the motion control patch universe to 
which you want to attach the axis.

6 From the ID drop-down list, select the ID on the motion control system with which 
you want to associate this axis. 

Note: The motion control system must be connected to your computer for the ID 
to appear in this drop-down list. If the system is not currently connected, you can 
also type the ID directly into this drop-down list box.

7 Click OK.

Step 3 - Attaching objects to the movement axis

To attach an object to a movement axis

Notes: 

 You can attach one or more objects to each axis; however, each object can be 
attached to only one axis at a time. 

 When you attach an object to a linear axis, the distance from the axis to the 
object does not affect the object’s movement; the object will always follow the 
path of the axis regardless of where you have placed the axis or object. 
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 When placing the object to be rotated in your drawing, note that its position 
relative to the rotational axis is important. The distance from the central point 
of the axis to the object represents the size of the circle in which it will rotate. 
To have the object rotate in a very tight circle (for example, a dancer doing a 
pirouette, or a spinning object), place the object directly on the center point of 
the axis.

1 Place the object that you want to attach to the axis at the appropriate position in 
your drawing, either by adding a new object, or moving an existing object to this 
location.

2 Select the object, right-click, and then choose Properties.

3 On the General tab, from the Attach to Axis drop-down box, select the axis to which 
you want to attach this object.

4 Click OK.

Step 4 - Viewing moving scenery

You have two choices when viewing moving scenery:

 You can use the Moving Scenery designer tool and the Cross-Fade feature in 
Design mode to fade between looks containing moving scenery.

 You can use a DMX console or a motion control system in Live mode to control the 
movement of objects attached to patched movement axes. 

To view moving scenery in Design mode

1 In Design mode, in the shortcuts bar, click Looks.

2 In the Looks shortcut area, right-click, and then select New Look.

3 In the Name box, type the name of the new look.

4 In the Fade time box, type the fade time in seconds for this look. 

5 Click OK.

6 Scroll to the bottom of the Looks shortcuts list.

7 Click on the shortcut for your new look.

8 Click the Moving Scenery Designer Tool icon ( ).

9 From the drop-down list in the Scenery window, select the appropriate movement 
axis. 

10 Click the slider to advance the object to the position where you want it to start on 
the selected axis. 

Note: In the Start box, you can also type the object’s position as a percentage of 
its full range of movement. For example, to show the object at the exact half-way 
mark on the movement axis, type 50. 

11 To create the next look, in the Looks shortcut area, right-click, and then select New 
Look.

12 In the Name box, type the name of the new look.

13 In the Fade time box, type the fade time in seconds for this look. 

14 Click OK.

15 Scroll to the bottom of the Looks shortcuts list.

16 Click on the shortcut for your new look.

17 From the drop-down list in the Scenery window, select the appropriate movement 
axis. 
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18 Click the slider to advance the object to the position where you want it to start on 
the selected axis. 

19 Ensure that the Fade looks button is enabled so the look fades instead of jumping 
directly to the next look. 

Tip: If the button is not enabled, then you can “jump” from one look to the next by 
clicking the look shortcuts in the shortcut bar. Even if the button is enabled, you 
can always jump to the next look by right-clicking the look shortcut, and selecting 
Jump to.

20 To watch the “fade” from the first look to the second look, click the shortcut for the 
second look. The object moves from the starting point of the first look to the 
starting point of the second look over the period of time that you specified as the 
fade time for the second look. 

Tips: 
 For a more realistic view of the fading between looks, click the Shaded tab.

 To jump directly to a specific look, right-click the look, and then select Jump to.

 For details on controlling the object’s movement with a console device, such as 
the Mini Console, see “To control a DMX patched movement axis with a console 
in Live mode” below or “To control a motion-control patched movement axis 
with a motion control system in Live mode” on page 68.

To control a DMX patched movement axis with a console in Live mode
After you have patched a movement axis in Data mode, you can use the applicable 
console device in Live mode to control the movement of any objects that are attached 
to the axis. 

To control the object, the DMX patch is allocated two channels with the following 
controls:

 First channel (Move): The first channel is for coarse movement and can be used 
to advance the object quickly to any position along the entire path, from start to 
finish. 

 Second channel (Move Fine): The second channel is used for further refining 
the object’s position that you set with the first channel. Adjust the slider on the 
second channel to move the object very slightly either forward or back from its 
current position. The movement achieved with this channel is so fine, that it is best 
viewed on linear axes that are quite long. Note that for rotation axes, the 
movement is so slight, that you may not be able to see it.

1 Ensure that the console device is connected to the patched movement axis. For 
details on connecting a console, see “Step 2 - Connecting to a console” on page 
56.

2 To move the object quickly along the movement axis, adjust the slider on the first 
channel, stopping at the position where you want to leave the object.

3 To move the object in fine increments either forward or back from its current 
position, adjust the slider on the second channel.

Tip: To view fine movement, the object must be attached to a very long linear 
axis, or be set to rotate in a very wide arc. It is also a good idea to zoom in quite 
close to the object before moving it.

To control a motion-control patched movement axis with a motion 
control system in Live mode
After you have patched a movement axis in Data mode, you can use the applicable 
motion control system in Live mode to control the movement of any objects that are 
attached to the axis.
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Based on the type of system that you are using, you can control the object in different 
ways. The following procedure outlines how to control the object(s) with WYSIWYG’s 
Motion Control Console.

1 Launch the Motion Control Console.

2 Ensure that the Motion Control Console (or the motion control system if you are 
using one) is connected to the patched movement axis. You connect the Motion 
Control Console (and motion control systems) in much the same way as you 
connect consoles. For details, see “Step 2 - Connecting to a console” on page 56.

3 To change the settings of a patched movement axis, highlight the axis in the left 
pane, and then choose from the following settings:

 ID box: To change the ID of the movement axis, type the new motion control 
ID. 

 Travel box: Type the distance (in meters for linear axes, in degrees for 
rotational axes) that you want the object to travel along or around the axis. 
This can be the full length/angle of the axis, or only a portion of it if you do not 
want the object to travel along/around the full path. For linear axes, if you type 
a value that is longer than the actual axis, the object stops at the end of the 
physical axis.

 Type: If you change the axis type so that it does not match the axis that you 
have drawn (for example, if the actual axis is linear, but you choose rotational 
here), the cell in patch view turns to red. 

 In the Mode area, select the type of movement for the object:

 Static  Select this option if you want to specify the precise location of a 
static object on the movement axis. You can then use the position slider at 
the bottom of the window to adjust the position and control the movement 
of the object manually.

 Bounce  Select this option if you want the object to move forward and 
backward in a continuous loop along the movement axis.

 Forward  Select this option if you want the object to move forward along 
the axis from start to finish, and then start over again at the beginning in 
a continuous forward loop.

 Backward  Select this option if you want the object to move backwards 
along the axis from finish to start, and then begin over again in a 
continuous backwards loop.

 Duration box: If you have chosen any moving Mode value (that is, any value 
except Static), you can specify the length of time (in seconds) over which you 
want the full range of motion to take place. The larger the number you type in 
this box, the slower the object moves.

 Position slider: For all moving modes (bounce, forward, backward), the slider 
indicates the position of the object when the console is sending data to 
WYSIWYG. For the static mode, while the console is started, drag the slider to 
to adjust the position of the object on its axis. The position value changes in 
the box in the left pane.

 Position box: While the console is sending data to WYSIWYG, for all moving 
modes, this box shows the progress of the object’s movement along its axis; 
for the axes in the static mode, you can type the precise location of the object 
on the axis.

4 Click Update Axis to view your new settings.

5 Click Save to save the changes.

Note:  If you make any changes to the axis settings and save the changes, you 
can revert to the previous settings by clicking Load.
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Lesson 14 - Using the Image Manager

Introduction

You can store images as sources in WYSIWYG using the Image Manager. By assigning 
textures to saved sources instead of to specific images, you can change or modify the 
texture of multiple objects at the same time using the Image Wizard.

The Image Manager also enables you to perform minor image modifications, such as flip 
horizontal or flip vertical to images without permanently changing the source file. This 
feature is useful in situations where the texture is flipped as a result of incorrect surface 
winding. For details, see the WYSIWYG Reference Guide.

You can use the Image Manager to create subsources of an image (i.e., divide the 
image up), which can then be applied to objects such as surfaces, screens, LED walls.

Step 1 - Creating an image source in the Image Manager

To access the Image Manager

1 In CAD mode, select Tools > Image Manager.

Result: The Image Manager appears.
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To create a new image source in the image manager

1 In the Image Manager, click New.

2 Browse to locate the image on your computer, and then click OK.

Result: The Image is added as a source. 

Notes: 

 Source Name: The image’s file name.
 Source Path: The path to the physical file. Click the file open icon  to select a 

new file.
 Flip Horizontal: Click this option to flip the image source horizontally. For details, see 

To flip an image source below. Note that you cannot flip image subsources.
 Flip Vertical:  Click this option to flip the image source vertically. For details, see To 

flip an image source below. Note that you cannot flip image subsources.
 Dimensions: The file’s dimensions in pixels.
 In Use: Informs you of whether the image source is in use. If the image source is 

currently in use, it cannot be deleted from the Image Manager.
 Display Settings

 Show image at: Select the zoom level for the image. You can choose to "fit" the 
image in the display window, or show it at a percentage of its actual size: 100% 
or 200%

 Display Borders: Select this option to show the subsource borders in the display.
 Display Selected Only: When you have selected a subsource in the table, click this 

check box to only show the subsource in the display area; if you do not select 
this checkbox when a subsource is selected, the entire source is shown (with 
the subsource borders highlighted in the display if you selected Display Borders). 

Step 2 - Flipping and exporting image sources

To flip an image source
In situations where a surface was drawn in a clockwise direction, the texture may 
appear to be “flipped” either horizontally or vertically. To avoid this problem, flip the 
image source using the Flip Horizontal or Flip Vertical checkboxes, as shown below. Note 
that you cannot flip image subsources; only the actual image source can be flipped.
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1 Open the Image Manager.

2 In the table to the left, select the image source that you want to flip.

3 Based on the direction in which you want to flip the image, select either Flip 
Horizontal or Flip Vertical.

Result: The image is flipped, as shown in the following sample graphic, which was 
flipped vertically.

To export an image source

After flipping the image, you may want to save your changes to a new image file as 
follows:

1 Open the Image Manager.

2 In the table to the left, select the image source that you want to export.

3 Click the Save icon in the top left of the window.

4 Type a name and select a file type for the new image, or accept the default file 
type of PNG.

Note: When exporting an image source the default file type is PNG, but you can 
choose a different file type, if desired; when exporting a subsource, you cannot 
choose the file type. The subsource is exported to the same file type as its source. 

5 Click OK.

Step 3 - Correcting missing images

If you have turned off the option Save external textures within the document in Application 
Options > File Options, when you move image files from their original location, they 
may not load from within WYSIWYG. When this happens, the image source will be 
highlighted in red, as shown in the following graphic:
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To address this issue, select the image source highlighted in red, click the folder icon 
beside the Path box, and browse to select a new image. When you are finished, click OK.

Step 4 - Creating image subsources

Just as with videos, you can create one subsource or multiple subsources from an 
image using the following procedures. Image subsources are useful in scenarios where 
you need to apply part of an image to one object and another. Normally, to do so you 
would need to open the image in a photo editing software program, make your edits, 
crop the image, and then import two images. However, with the image subsource 
creation feature, you can just import the source file, and create the necessary 
subsources within WYSIWYG. For example, you could use this procedure if you have a 
photo that you want to break into quadrants (2 x 2), and then apply each quadrant to a 
separate surface, screen or LED wall, etc.

To create a single image subsource

1 In the left pane of the Image Manager, click to highlight the image for which you 
want to create a subsource.

2 In the bottom left corner of the window, click Single Subsource - create one.

3 Type the subsource name.
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4 By default, the system uses the start and end coordinates of the selected source, 
but you can change these values as desired. When you change these values, the 
system automatically updates the dimensions. 

5 Click the Border box to specify the color of the border that will appear around the 
subsource when displayed.

6 Click OK.

To create multiple image subsources

1 In the left pane of the Image Manager, click to highlight the image for which you 
want to create subsources.

2 In the bottom left corner of the window, click Multiple Subsources - create many.

3 Type the subsource name. 

4 Define the subsource matrix by specifying the number of columns and rows. The 
dimensions of the subsources are displayed for your reference.

5 By default, the subsources are created by taking the overall source area (height & 
width) and evenly dividing it by matrix provided. However, you can modify the total 
area by changing the start/end coordinates and, therefore, the overall dimensions 
used to create the subsources. To do so, click the check box beside Modify total area 
for subsources, and then type the new coordinates.

Notes: 

 Subsources are always listed below the source from which they were created.
 The table in the Image Manager provides a convenient way of displaying source/

subsource information; all sources and their subsources are grouped, and can be 
expanded/collapsed.

 You can rearrange the columns in the table by clicking the column header and 
dragging it to the new position. 

 You can adjust the width of columns by clicking the column border and dragging 
the column to its new width. 

Step 5 - Changing the properties of image sources and subsources

Note: If you change the source after the subsources were created, and the new source 
has different dimensions that do not match the subsources dimensions, the affected 
subsources are highlighted in yellow (and a dialog appears to notify you as such).
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When you select a row in the Image Manager table, the properties of the image source 
or subsource are displayed in the Source Properties area of the window. You can change 
various properties of the image source and subsources as follows:

 To change the border color of image subsources, in the table, click the appropriate 
border color and then click on the drop-down box that appears to select the new 
color. Click Update.

 To change the name of the image source or subsource, in the table, click the 
appropriate row. Type the new name, and then click Update. 

 If you have already applied an image to multiple objects, and then you want to 
replace the source file with something different, you can make the change once in 
the Image Manager and have it automatically applied to all related objects (i.e., 
you don’t have to individually apply the changes to each object's properties). To do 
so, you change the underlying source file to the Image name. 

 You can define a subsource either by its start/end coordinates or by its 
dimensions:
 To resize the subsource, click the appropriate row in the table. Change the start/

end coordinates as desired, and then click Update. Note that if you change the 
coordinates, the system updates the dimensions automatically. 

 To change the dimensions of a subsource, click the appropriate row and then 
type the new dimensions. Note that when you change the dimensions, the 
system will automatically add to the start coordinate to determine a new end 
coordinate. Click Update.

Note: You can use the Quick Video/Image Tool to apply the Image Subsources. For 
details, see the WYSIWYG Reference Guide.
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